EVE 5.9 Enhancements

1. Windows 8 Tablets
Two new User Interfaces have been added called Touch Advanced and Touch Simple which provide a better experience on
Windows 8 tablets. You can use these interfaces on computers without touch screens as well, of course.
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Create and send purchase orders and
receive goods into inventory
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Calendar
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More options are now available on the User Interface form to allow you to configure EVE to work better on tablets. For

instance you can increase button sizes to make them easier to touch with your finger. Also toolbars can be configured to

appear on the right hand side of data entry forms (rather than always at the bottom in previous versions of EVE). This makes

the toolbar buttons more readily available when the on-screen keyboard takes up space at the bottom of the screen. NOTE:

you must use the Pro editions of Windows 8 and Windows 8.1.

Also, various screen elements (such as the buttons in the screenshot above and Coolbar elements) can now be dragged with a

finger rather than having to use a scroll bar.
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Coolbars have been added to the Customer and Stock Item Data Entry forms. These are turned off by default but you can turn
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them on by clicking the Options button and then clicking ‘Coolbar Visible’'.
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2. Loyalty Program
EVE has long supported a Loyalty Program. However, until now, it has required you to manually assign loyalty credit to
customers. Now EVE can be configured so loyalty credit is automatically assigned when Invoices are saved. The credit just
earned can be printed on the receipt if you wish by adding a Text field to the print layout called “LoyaltyCredit”. Or you can
print the total outstanding loyalty credit for the customer by adding a Text field called “TotalLoyaltyCredit”. You can assign the



rate (i.e. percentage of net price) at which loyalty credit should be earned to each Stock Item (this can be done in bulk using
the ‘Update Multiple Rows’ feature).

You can configure different Invoice Types to handle loyalty credit in different ways. E.g. resorts may wish to configure EVE so
that loyalty credit is not assigned on Ongoing Invoices. The credit will then be assigned when each Ongoing Invoice is
converted to a Sales Receipt (i.e. when the customer checks out of the resort), thus making the credit available to the
customer when they next return to the resort. Others may wish to configure EVE so that loyalty credit is assigned immediately
regardless of the Invoice Type.

In the past, you could choose to use a Group to keep track of which customers were in the Loyalty program. Or you could
choose to have all customers in the Loyalty program. A third option has now been added so you can use a Club to keep track
of which customers are in the Loyalty program. In this way, all members of your club could automatically get loyalty credits
when they purchase goods from you. An added benefit is that, when a club membership expires, the customer will no longer
receive loyalty credits on their purchases (any existing credits are retained though). You can use this as an incentive to your
customers to renew their club membership. Choose which of these 3 methods you want to use on the Customers tab of the
Options form.

The original way of assigning loyalty credit is still available if you choose —i.e. whereby credit is only assigned when you tell EVE
to assign it.

3. Spanish

In addition to the existing options of English and Italian, EVE can now be displayed in Spanish.
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4. PIC OnLine

Enhancements have been made to EVE’s interface with PADI’s PIC OnLine process to support recent new PADI developments.

1/ ReActivate: you can submit ReActivate notifications for those students wanting to ReActivate e.g. their Open Water or
Advanced Open Water certification. You do this by creating a certification record in EVE using the new ReActivate course type
and then submitting it via the regular PIC OnLine interface in EVE. When ReActivate is chosen as the Course Type on the
Certification form, you'll see that the Certification Date and Certification number fields are replaced by Academic Date and In-
Water Date. Make sure a valid Digital Code entry is entered on the PIC OnLine tab.
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2/ PADI Touch: On the PIC OnLine tab of the Certification form you can now enter a Digital Code —i.e. a value supplied by PADI
to a student taking a PADI Touch class. When a certification is submitted to PIC Online that contains a valid Digital Code, no PIC
credit is debited from your account.

3/ PADI ID: you can now save a student’s PADI ID to their Customer record. See screenshot below. If present, EVE will submit
it along with other details on the PIC (unless a Digital Code is also present in which case PADI ID is not required).

4/ Marketing emails: two new pieces of information are now submitted to PADI when you upload a PIC:

i) Whether the student wants to receive marketing related emails from PADI

i) Whether the student wants to receive mailings from PADI Partners such as Project AWARE.

You can define the values on the Details page of the Customer form. You can set default values for the 2 check-boxes as you

would for any other field in EVE. i.e. click New Customer, put ticks in the boxes as appropriate (e.g. if you think that most new

students would like to receive PADI emails but not PADI Partner emails, put a tick in the “Receive PADI marketing emails” box

and leave “Receive PADI Partner mailings” unticked), click the yellow star button at the bottom of the Customer form and click

Save Defaults.
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5. Transport.web (US and Canada only)
EVE has long supported Transport Client from Merchant Warehouse to provide integrated support for credit card processing in
North America (along with X-Charge from Accelerated Payments). Transport Client is not supported on Windows 8 so EVE now
supports Transport.web (in addition to Transport Client and X-Charge) which works on all versions of Windows including
Windows 8. This means you can accept credit cards on your Windows 8 tablet (provided you have a USB port on your tablet
for the mag-stripe reader to plug into).

NOTE: although you can continue for the immediate future with Transport Client, Merchant Warehouse strongly recommend
you upgrade to Transport.web as soon as you can as at some point they will cease support for Transport Client.

Currently the Transport.WEB solution only supports an entry device made by Magtek. Contact Merchant Warehouse to obtain
your MagTek device.

6. Commissions
In previous versions of EVE, staff commission was assigned to the invoice as a whole. i.e. the staff member referenced in the
Employee box earned commission on all the items being sold. This has now changed so that different staff members can earn
commission on different line items on the Invoice. And multiple staff members can even earn commission on each item on the
Invoice. E.g. if 2 staff members were equally responsible for selling an item, you can split the commission between them. By
default, the staff member referenced in the Employee box will get commission on items on the Invoice but privileged users can
override that.

Invoice: #4175 (David Dalton)
Cost Center Emerald Island Divers L—L'{ Inwoice # | 4175
Type* | Sales Receipt Ticket ¢ |24
Employee® | Roger Lockwood | Created |10/24/2013 12:40:46 PM
Customer” | David Dalton ,O"\.”}
. Shopping Basket | Paid Invoices | Payments |
Barcode # [a Stock # [A= Description | A"
| Qty | Stock # Total Stock ltem ||||| Stock Type | Manufacturer ||l Creation Date Commission Employes
o 554603 $18.00 EXTENSION FOCUS Cameras Sea & Sea 10/24/2013 12:40 PM Charlie Campbell (100%).
11 PHILNen  $2.690.00 Philippines 2074 Trip Trips Emerald Island Div  10/24/2013 12:40 PM Brian Murphy {50%:).Dave Lewis (50%).
Search
< >
ltems Awaiting
MNotes : Payment
Sub-Total $2,708_00
Tax $0.00
Paymentz
Total $2,708.00

When using the Seating Planner to sell places on courses or trips, the Staff section has been enhanced so that check-boxes are
displayed next to each staff member on the course/trip. The staff member that is logged on to EVE is also shown. You can put
a tick next to one or more staff member(s) before dragging a customer or an add-on sale item onto the planner to sell it. The
ticked staff member(s) will get the commission. In this way, if e.g. a customer decides to do an extra dive while they’re out on
the boat, their instructor may easily be given the commission for it. If you’re not interested in handling commissions in this
way, you can turn off this feature using the Settings button on the Seating Planner so EVE works in the same way as before.
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7. Course Roles
Roles (e.g. Instructor, DiveMaster, etc.) can now be assigned to staff members on courses as well as Trips. In the past, the
available list of Roles was taken from the Customer Types section. This has now been changed so Task Types are listed. This
change was made because of the Commission on Course/Trip Roles feature described below.

| =5 Course: RESC 3/16/2014 = E'“
General | Modules | Dates | Times | Staff | Locations | Summary | Customers | Options Purchased | Expenses | Stock ftems | Requirsments
iD 510 *Staff
Course Type™  Rescue Diver . L_Q | Staff Member Role
Start Date”| Sunday . Mach 16,2014 [~ S Dby ety
Dave Lewis Dive Master
End Date®| Monday . March 24, 2014 E- |
Course # [RESC 3/16/2014 l Add - REmove '
Min Mo." |2 Max Mo = {12
MNotes
Status™ | Incomplete By
- Will prirt on Invoice
Language &=
More Info

Will NOT print on Inveice

Created 3/15/2013 2:25:45 FM
Last Updated 10/24/2013 2:46:12 PM

8. Commission on Course/Trip Roles
On the Task Type form you can now indicate how much commission (if any) should be assigned to staff members when they
perform tasks of that type. You do that by linking the Task Type to a Stock Item. On the Task Type form, you can indicate



whether tasks will only contribute to the staff member’s commission once it is marked as complete or whether it will
contribute regardless of the completion status.

Task Type: Prepare Rental Gear = B
Calendar Calors
D1
Use this section to set the o
Task Type™ |Prepare Rental Gear colors that will represert the it For= Color
Task Type in the Calendar =% Back Color

[] Course Role? [[] Unavailable?

[[] Trip Rele? Created 10/6/2004 5:47:16 FM
Last Updated 9/20/2005 8:29:02 AM

Commissi Retail Price(s) on this Stock ttem detemmine the
Stmmf;mn Prepare Rental Gear :H- Amount of Commission to be paid for Tasks of
ock ftem this Type

When Paying Commigsion for Tasks of this Type...
(®) Pay Commission on Tasks marked as Complete
Use Task Completion Dates to calculate Period
() Pay Commission on all Tasks regardiess of Status
Use Task Completion Dates if present. Ctherwise use Due Dates
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The Retail Price on the linked Stock Item indicates how much commission will be earned. You can indicate whether the price
represents a fixed price for completing the Task regardless of how long it took or whether the price is per hour, per day, etc.
When calculating the commission on a Task, EVE will use the Actual Dates (if present) or the Due Dates on the Task to
determine how long it took.

Stock Item: Prepare Rental Gear =

[ General . E'.;tores I Suppliers Prices Sioc:k Levels . Seﬁal Nos | Ii‘ackages - Lirks - -Docurnerrts . WE C-)nlﬁne []1art . Hiétor:.':

#

.EI'nBIE|d leland Divers l ”(jharliebnljne | Emerald lsland Divers | Emerald Island [ * v
Retail Prices Show Price in EVE Online? ' Cost Prices |
Sales Tax |VAT 21% et -oiIEl
| Price Type Urit Price | Inc. Tax | Status ¥ N
b | Retil S2000  $2420  PriceSet || |Pertour |
| Agent.. £20.00 524.20 Use Retail [Mene]
| |MumniPrice $2000  $2420  UseRetil [ OneOf
(Club Member $2000 52420 Use Retai
| DiveMaster 52000 82430  Use Retsil PerMinute
" |Employee  S2000 $2420  UseRetsil Bobioti
__ EVE Online S20.00 524 ) Use Retail Perfear
| Instructor 52000 52420  Use Retail
| Student S2000  $2420  Use Retail
/q

Pricing Method | PerHour [ -i

When you assign a staff member to a course or trip along with their Role, EVE looks to see if the Role (Task Type) has a

commission stock item linked to it. If it does, EVE automatically adds a Commission line to the Expenses tab of the Course/Trip
for amount he/she will be paid. Privileged users can override the amount.
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o/ Course: RESC 3/16/2014

General | Modules | Dates | Times | Staff | Locations | Summary | Customers | Options Purchased | Expenses | Stog 4 |+
[tem Staff Amount | Tax |Total | Tax Band Expense Date Type [

4 Instructor Brian Murphy 22000 5420 2420 VAT 1% 100242013 325 PM Commissions..
Dive Master  Dave Lewis £10.00 210 21210 VAT 21% 10242013 326 PM Commissions..

£ >

Add Remove Sub-Total £30.00 | Tax £6.30 | Total £36.30
p. R [ %] &b || £% Recumence 4 ) Mew Save

EVE now has new commission reports that, in addition to the commissions on sales that it has always shown, now include

sections for course and trip role commissions and general task commissions. You can also run Closing reports for commissions
outside of the existing Closing reports. i.e. if you run a Commission Closing, EVE only reports on commissions that have not

previously been reported upon. This makes it easier to track staff payments. You can also run a Commission Closing for

individual staff members if you want so, if a particular staff member wants to be paid early this week/month you can Close out

his/her commissions without running the reports for everyone.

9. Calendar: Staff Activities

A new feature has been added to the Calendar that lets you see staff availability at a glance. You can choose which sub-set of
your staff you want to see — e.g. all instructors, instructors and divemasters, sales clerks, all staff, etc. EVE will show all those
people on the Calendar and those with no activities on the day in question will be shown in yellow, and those with activities in

pink.
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10. New Trip Pickups feature.
EVE has always supported a way of indicating that pickups are required for trips. This is still supported and you can continue to
use it if you like the way that works. However, we have added a new way of handling pickups as well. In the new way, you can
create Pickup records that are independent of any particular trip or course and you can assign customers to the Pickup. In this
way, if you are a busy resort with several trips starting at the same time, you can organize a single pickup to handle all those
trips.

Pickups can be created and places assigned using the Seating Planner. There is a new “Activity Customers” tab in the
Customers section of the Seating Planner. That lists everybody who is taking part in an activity (i.e. participating in a course or
trip) on the day in question. Their Hotel and Room # is shown along with the “Region” (or Route) their Hotel is on. i.e. you can
group Hotels that are near to each other into Routes, sort by the Route in the Seating Planner and then drag all customers on
that Route onto a Pickup.

You can print Pickups and give the report to the bus driver the evening before. The report will show customer details including
Hotel and Room number, etc.
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11. Seating Planner enhancements

Better support for Groups

To make it easier to work with booking families and friends onto trips and courses, EVE now has better support for Groups in
the Seating Planner. If you drag a customer from any of the customer lists and drop them on the background of the Seating
Planner, EVE will open Group(s) the customer is a member of. You can then select all (or some) members of the group and
drag them onto a course or trip together. Additionally you can create Groups in the Seating Planner. Highlight one or more
customers in one of the customer lists and then click New -> Group. The Group form will be shown with all the selected
customers added to it and you can simply click Save to create the new Group.



Auto-assign seats

In real world situations, people book places on trips and then cancel. This can lead to less than ideal seating arrangements on
the boat. Staff in charge of organizing the bookings may not know which customers should be seated together. To help with
this, EVE now has 2 ways to auto-arrange the seating plan:

i) by Enrollment Date : usually people that want to sit together will enroll together so a single click will arrange the
seating in order of enrollment date/time.
ii) by Group membership. EVE can look to see which people are in the same Group(s) and arrange them accordingly.
Choose which method you want by right clicking on the trip and then clicking Reassign Seats.

Special Arrangements
You can now configure the Seating Planner to show customers’ Special Arrangements.
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12. ScubaTribe
An interface has been added to the ScubaTribe (scubatribe.com) website. ScubaTribe provides a way for you to invite your
customers to review your courses, trips and other services. Now, in conjunction with the EVE Agent, you can automatically
send a congratulations email to people that just completed a course or attended a trip and include a link in the email to your
review page on the ScubaTribe site. An ScubaTribe ID value is automatically built into the EVE Agent link so the feedback can
be linked to the appropriate customer/course/trip. To use this feature, you'll need to sign up for an account at
scubatribe.com, generate an API key and then apply that to the EVE Agent by clicking View then Options and clicking on the
ScubaTribe tab in the EVE Agent. On the EVE Agent job(s) that send emails to people on course/trip completion, make sure the
ScubaTribeCode box is ticked in the list of columns on the Data Source tab. It is that tick that tells the EVE Agent to generate a
new unique ID value to insert into the link included in the email. Add a Merge Tag to your Outlook email called [ReviewURL] or
to your MailChimp campaign called *|ReviewURL| *

13. Copy Contact Details
On the Customer form, if you click the Options button at the bottom left (i.e. the button with the picture of a hammer and
wrench), you'll see a new option called “Copy Contact Details from Customer”. When you click that, EVE will show the names
of recently added/modified customers. You can click one of those to copy information from the chosen customer onto a new
customer record. E.g. if multiple members of a family are being entered into EVE, you can enter details for the first and then
quickly copy their details (address, phone number, etc.) onto subsequent records. This has some advantages over cloning in



that you can configure what information is copied. E.g. waiver info, height, weight, etc. can be configured to not copy.
Information about which fields are copied is stored on the database.

14. Image Capture
In addition to WIA (Windows Image Acquisition), EVE now supports Windows Portable Devices —i.e. an alternative way to
control cameras in order to capture student images and other images. You can choose which method of image capture your
camera supports by clicking the Options button on the Customer form and then the ‘Configure Image Acquisition’ option. In
order to support Windows Portable Devices, EVE uses a Microsoft library called Microsoft Expression Encoder. When you first
use this option, EVE will check whether the library is installed on your computer. If not, it will ask you if you want to install it.
You will need to click Yes if you want to use this feature.

15. Support for Microsoft POS
EVE now supports the Microsoft Point of Sale component which gives easier access to point of sale equipment —i.e. cash
drawers, customer pole displays, etc. Note: this is only supported on Windows 7 and Windows 8.1 and later. You can choose
to use this feature on the Point of Sale tab of the Options form.

16. MailChimp
MailChimp lets you send each Campaign only one time. If you need to send a Campaign more than once you can Replicate it
and then send the copy (the EVE Agent does an automatic Replication each time it sends a Campaign). We have now added a
Replicate button to the Export form in EVE. Click that before you send a Campaign if you want the email to be available more
than once. If you forget to do that, you will need to login to your MailChimp account and manually Replicate it.

Each column of information that you export to MailChimp when using the EVE Agent can be used as a Merge Tag in the
MailChimp Campaign — e.g. Trip Start Date, Birth Date, etc. Until now it was a little awkward to find out the name of the
Merge Tag that MailChimp would use since MailChimp has a maximum length on the number of characters allowed in each Tag
and so the EVE Agent needs to truncate them if they’re too long. To make it easier to find the Merge Tag name, we now show
a list of all available Merge Tags on the Advanced tab of the email Job form in the EVE Agent.
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Campaigns that were imported into MailChimp can only be edited in MailChimp itself by modifying the HTML code of the email
and that can be a difficult task. We have therefore added a new button called ‘Edit Campaign Content’ to the Email Job form in
the EVE Agent. When clicked, it communicates with your MailChimp account and pulls the HTML of the Campaign back into an
editor in the EVE Agent so you can make changes there using a graphical interface. Note: this method is only applicable for



Campaigns that were imported into MailChimp. If you created a Campaign in MailChimp itself using a MailChimp template
then you cannot use this feature and instead you need to edit the Campaign content in MailChimp.

17. Delivery form Serial numbers
In previous versions of EVE, when receiving items on a Purchase Order Delivery, if serial numbers were required, the message
only showed the Description of the stock item in question. Color and Size are now added to the description so it’s more
obvious which item you’re entering the serial numbers for.

18. Clubs

Privileged users can now add members directly to the Club form by clicking the Add button on the "Members” tab.

Date range controls have been added to the Club Membership search form so you search on membership expiry date, etc.

19. Travel Agent:
A new Coolbar button can be added to the Invoice form called ‘Agent Items’. This is for use mainly by resorts who work with
travel agents. When clicked, EVE pulls all outstanding line items onto the Invoice for the Agent (customer) in question.

20. Invoice Type form:
By default, when you Refund an invoice, a new invoice is created with an Invoice Type of ‘Sales Receipt’. You can now define
what type of Invoice Type is used on the refund (the default is still Sales Receipt). This change was made as some countries
have firm rules about what Invoice Type is used.
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21. Change Invoice Date/Time
Privileged employees can now change the date on a previously saved invoice. To do this, open an invoice, click the Options
button at the bottom left and then click Change Invoice Date/time. USE WITH CAUTION!



22. Rounding
A new option has been added to the Sales tab of the Options form called ‘Round Price Before Calculating Tax’. If this is
checked, when an item is added to an Invoice, EVE will first round the Pre-Tax figure to 2 decimal places and then calculate the
tax. If the box is not ticked, EVE will calculate the tax on the pre-rounded price.

23. Certification form
In the past, the Certifications form showed minimal information until the “More” button was clicked. At that point the form
expanded and made more fields of information visible. To make the form more consistent with other forms in EVE, tabs have
been added and all the advanced fields are present on those tabs.

A new field has been added to the Enrollment tab called “Referring Instructor #”.

24. New Course Report
A new report accessible from the Calendar has been added called Calendar Swim Roster. For the chosen day, it shows a list of
students in appropriate courses pre-selected by you along with the course times and details of their completion date. As the
name suggests it is intended for use by dive stores with a swim program.
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25. Linked Customers

In the tabbed section on the General tab of the Customer form, there is a new tab called Linked Customers. Here, you can link
other customers to the active customer. E.g. if you run swimming lessons, you could create a customer record for the parent
and then link one or more children to them.

26. Postcode Lookups
A postcode lookup feature has been added to the Customer data entry form. You can enter a postcode and click the
exclamation mark button to tell EVE to lookup address details associated with that postcode — e.g. City, State, etc. Since we
can’t install every postcode for all addresses worldwide, we have added an Import process so you can import postcode
information from Excel that is appropriate for your location. You can see the format required for the Excel import sheet by
clicking File then Import then Import from Excel; select ‘Postcode Lookups’ and click Show Template. Alternatively, you can
manually enter postcodes and related address details using the new Postcode Lookups button in the Customers module.

217. Recent Records
When you open a record in EVE (e.g. a customer or invoice, etc.) it is added to the Recent Records option on the File menu.
You can use that menu to quickly open a record that you were recently looking at. In the past, the list of recent records was
only retained for the current EVE session. In EVE 5.9 it is saved to the database when EVE closes so it’s available again when
you restart EVE.

28. Firewall
It can be a challenge for non-technical users to make EVE work on a network as, for security reasons, Microsoft don’t allow
other PCs to automatically access resources on the PC containing the database. For this reason, users have had to fiddle
around in the past to open up Firewall ports to allow remote connections. We have now added an option to make that
process simpler provided you’re using the standard Windows Firewall on the computer where your database is installed. To



open up the 2 ports that EVE requires, on the computer housing the database, click the EVE icon at the top right of the
program and then click “Open SQL Server Ports 1433 and 1444”

29. Rental Prices
The Rental Prices tab on the Stock Type and Equipment Item forms let you type prices into a grid along with the number of
rental days to which the price relates. This is very flexible but can lead to a lot of work. To simplify the data entry we have
added a Rental Price Wizard to the Rental Prices tab of the Stock Type and Equipment Items forms. When you click the button,
a form is displayed that lets you define parameters. When you click OK, EVE will use those parameters to fill the prices grid.
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30. New Columns on Search forms

A new optional column has been added to the Invoice Search form called “Owed On Invoice”. You can turn it on by clicking the
Options button at the bottom left of the Invoice Search form and then Customize Columns. Put a tick in the “Owed on Invoice”
box and click OK. The column is most useful when you’re searching for Ongoing Invoices and, for each invoice displayed, it will
show the difference between the shopping basket total and the amount already paid on the Invoice.

A new optional column has been added to the Stock Item Search form called Last Delivery Date.

31. Tax Exemptions
EVE has always allowed you to indicate that certain customers are exempt from certain taxes. In previous versions, if someone
that was exempt from all taxes purchased an item, EVE looked through all tax bands on the database for the first one that was
zero rated and applied that to the invoice item. That was fine in most cases. However, consider the following case from Store
Xin Alaska: Seniors are tax exempt. So are Government workers. Store X needs to report Senior taxes separately from
Government taxes. Store X created 2 zero rated tax bands called Senior and Government but EVE always chose Senior for tax
exempt items. To resolve this, you can now mark both the Senior and Government tax bands as ‘exemptable’ and it a
customer that is exempt from Senior taxes makes a purchase, the zero-rated Senior tax band is applied and if a customer that
is exempt from Government taxes makes a purchase, the zero-rated Government tax band is applied. If a senior government
worker makes a purchase, EVE will choose one of the tax bands at random, as before.

32. New Popup-Note options
When you add a customer to an invoice, rental booking or service booking, EVE can be configured to show pop-up notes
relating to the customer. 3 new options have been added to the popup notes that can be displayed. You can turn on the new
options on the Popup Notes section of the Customers tab of the Options form.



i) Customer’s Club M/Ship will expire within X days. Put a tick in the box and set a value for X and EVE will warn you if
a customer that is a club member is added to an invoice if their club membership is due to expire within X days.

ii) Customer’s Quote will expire within X days. Put a tick in the box and set a value for X and EVE will warn you if a
customer that that has a Quote is added to an invoice if their Quoteis due to expire within X days.

iii) Customer’s Invoice is due to be paid within X days. Put a tick in the box and set a value for X and EVE will warn you
if a customer that that has an unpaid invoice is added to an invoice if payment on the unpaid invoice is due within
X days.

33. QuickPay

When taking payment on an Invoice, you can either use the Coolbar buttons on the right hand side to choose the payment
method or you can pick the payment method from the pick-list on the Payments tab. If most of your customers pay by credit
card and you use integrated payment processing in EVE, you need to make several key strokes and mouse clicks to complete
the transaction (i.e. click Credit at the prompt to confirm the Amount, swipe the card, click Save, etc.). To avoid some of those
steps, you can now choose one (and only one) payment method to be the “Quick Pay” method by putting a tick in its “Quick
Pay” box — see screenshot below. This will cause a Quick Pay button to appear at the bottom of the Invoice form. When
clicked, EVE will use that payment method on the Invoice and assume the customer is paying in full with that payment method.
Provided you also remove the tick from the “Show Card Details Prompt”, EVE will simply show the swipe form where you can
swipe the credit card and then, provided the card is approved, save the Invoice for you.
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34, PO form

A new column has been added to the Purchase Order grid that shows the current number in stock of each item on the PO. You
may find this useful e.g. when using the Restock Wizard to determine if you really need to order items added by the Wizard.

35. Delivery Note
A new "Delivery Note Number" field has been added to the PO Delivery form. You can enter there the number supplied on the
Delivery by the Supplier (if present).

36. Dive Profile

A new Dive Site picklist has been added to the Dive Profile form.



37. Certification Search
A “Cert. Priority” box has been added to the Certification Search form. You can use that to search for certifications of the same
priority — e.g. if you have specified that Adventure Diver and Advanced Diver have the same Priority (on the Course Type form),
you could enter the Priority value on the Certification Search form to see all divers who have either an Adventure Diver or
Advanced Diver certification.

38. Custom Popup Notes
EVE has always supported the ability to show popup notes when a customer is added to an invoice — e.g. “It's Mary’s birthday
today” or “John has no email address on file”, etc. Now you can add your own custom commands to show those popups. Do
that in the new “User-Defined” section on the Popup Notes tab of the Options form.

39. Stock Levels
In past versions of EVE, there was a NolnStock value on the Stock Item database table that held the number of units currently
in stock for each stock item. In addition, a history was kept for each stock item that indicated how many units were received
on each Delivery and how many of those remained unsold. EVE made sure that the sum of the history ‘unsold’ values matched
the number in stock value. The NolnStock value has now been changed so it is no longer an editable value on the database.
Instead, the value is Calculated by summing the History ‘unsold’ values. From the user’s perspective, this makes no difference
—the User Interface remains unchanged and you can do whatever you could do before with stock levels.

Issues Resolved
In EVE 5.8 an issue resulted in Store Sale prices being ignored in some cases. This has been resolved.

In previous versions of EVE there was an issue displaying the Course Enrollments by Month report when a non-English version
of Windows was used. This has been resolved.

In previous versions of EVE, an error resulted in the EVE Agent if you used an ID column (e.g. Country ID, Course Type ID, etc.)
on the Filters tab. Those ID columns were not required (as each had an accompanying regular field (e.g. Country, Course Type,
etc.)) and have been removed from the Filters tab.

In previous versions of EVE an error resulted when doing a Stock Item search if “Equipment Servicing” or “Equipment Rental”
was chosen as the Stock Type in the Search form criteria if customized columns were previously defined in the results grid.
This has been resolved.

In previous versions of EVE, the Seating Planner customer search gave an error if a search was performed for a customer that
had an apostrophe in their name — e.g. L’'orange

In the Administrator interface, Special Orders showed in the “Received” folder if other items on the same Delivery had been
received. This has been resolved.

In previous versions of EVE, an error (“Variable @AccountID already declared”) was sometimes shown if you clicked Close This
Account on the Account form. This has been resolved.

In previous versions of EVE, an error resulted when opening the Store form if there were no discountable Customer Types on
file. This has been resolved.

In previous versions of EVE, the Reservation form (loaded on the Customer form by pressing F9) was not closed when the
Customer form closed — it merely went behind the main EVE form. A new instance of the Reservation form was then loaded
each time the Customer form was loaded resulting in a decrease in available memory on the computer. This has been resolved.

In previous versions of EVE, it was possible to create Static Segment names that were too long for MailChimp to handle
resulting in an error when sending EVE customers to MailChimp. This has been resolved.



In previous versions of EVE an error (T_FOFormOpt) sometimes resulted when merging 2 PC records. This has been resolved.

Previously if you saved the column sizes and positions on the Day Trip form, columns were removed from the Pickups tab. This

has been resolved.

PICs submitted in the morning in the Far East (including Australia, NZ, etc.) reported error “pre registration send to code not
valid” as the date/time is the day before the GMT used by PADI. This has been resolved.

Error in the results when Profit Center Tax report printed. Resolved

In the EVE 5.8 setup, incorrect mail-merge fields were present in the Word for Windows Label templates resulting in an error
when printing labels to Word. The merge fields are now corrected.

Previously, users that were not authorized could view information on other people’s Desktops relating to their clock on/clock
off times. They are no longer permitted to view this information for other people unless they have the “Can View All Staff
Desktops” privilege.



